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Introductory Message
This Self-Learning Module (SLM) is prepared so that you, our dear learners,

can continue your studies and learn while at home. Activities, questions,
directions, exercises, and discussions are carefully stated for you to understand
each lesson.

Each SLM is composed of different parts. Each part shall guide you step-by-
step as you discover and understand the lesson prepared for you.

Pre-tests are provided to measure your prior knowledge on lessons in each
SLM. This will tell you if you need to proceed on completing this module or if you
need to ask your facilitator or your teacher’s assistance for better understanding of
the lesson. At the end of each module, you need to answer the post-test to self-
check your learning. Answer keys are provided for each activity and test. We trust
that you will be honest in using these.

In addition to the material in the main text, notes to the Teacher are also
provided to our facilitators and parents for strategies and reminders on how they
can best help you on your home-based learning.

Please use this module with care. Do not put unnecessary marks on any
part of this SLM. Use a separate sheet of paper in answering the exercises and tests.
And read the instructions carefully before performing each task.

If you have any questions in using this SLM or any difficulty in answering
the tasks in this module, do not hesitate to consult your teacher or facilitator.

Thank you.



Lesson
7

Creating Knowledge Products
in Multimedia Slide

Presentation

What I Need to Know

This module was designed and written with you in mind. It is here to help
you master the knowledge and skills that will lead you to use advanced features of
a slide presentation with text, graphics, and photos; hyperlinked elements;
animation; and embedded audio and/or video. The scope of this module permits it
to be used in many different learning situations. The language used recognizes the
diverse vocabulary level of students. The lessons are arranged to follow the
standard sequence of the course. But the order in which you read them can be
changed to correspond with the textbook you are now using.

This module focuses on creating knowledge products in multimedia slide
presentation.

After going through this module, you are expected to:

1. Use the advance features of slide presentation tool to create a multimedia
presentation with:

a. text, graphics, and photos;
b. hyperlinked elements;
c. animation; and
d. audio and/or video elements

What I Know

Choose the letter of the correct answer and write it on a separate sheet of paper.
1. Which type of template provides a design concept, fonts, and color scheme

for presentation?
a. Format c. Content
b. Normal d. Design

2. Which PowerPoint feature adds special effects to modify the appearance of
the slides and the timing between each slide?

a. Color Schemes c. Transition Settings
b. Animation d. Handouts

3. Which of the following options is not included in the Entrance options within
the Animations section in the ANIMATIONS tab?

a. Appear c. Fly-in
b. Fade d. Power Punch
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4. What program in Microsoft Office that enables us to create dynamic
presentations?

a. MS Word c. MS Excel
b. MS PowerPoint d. MS Publisher

5. In PowerPoint, this is a container for text or graphics.
a. Slide Master c. Place Holder
b. Table d. Text Box

What’s In

What is MS PowerPoint?

-is a program from Microsoft Office that enables us to create dynamic presentations.
(Computers for Digital Learners, Building Technological Skills for Life pp.161)

What are the parts of the MS PowerPoint environment?

The parts of the MS PowerPoint environment are File Menu, Quick Access Toolbar,
Title Bar, Sizing Button, Ribbon, Slide Tab, Slide Area, Status Bar, View Button,
Zoom Slider (https://prezi.com/m/4m_99z9nngpl/microsoft-powerpoint-environment/)

What’s New

Product presentations are an important part of selling your product to
prospective customers. In many cases, this will be the customer's first introduction
to your company and potentially your product. First impressions are critical. There
are also times when it is important to sell your product to the people inside your
company as well as investors. Proper preparation is vital to presenting your
product in the best light possible.

The following is a basic outline for a product presentation. You will note
that the maximum number of slides is twenty. Most sales calls allow 30 minutes for
the formal presentation, at two minutes a slide, fifteen slides is the appropriate
number. It is important to keep your presentation precise otherwise your point will
be drowned out in detail.

1. Introduction - In this portion you are going to introduce yourself and the
product in detail for the audience to have an idea on what you are
presenting. (1-2 slides)

2. Agenda - Though optional, but it is necessary to make sure that the
audience stays on track and that everyone knows what is happening and
what is going to happen next. (1 slide)

3. Company Information - Present company information in a precise and
comprehensive details to inspire the audience.
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4. Positioning - This must be a brief description of a product and its
uniqueness over the other in order to help your potential users understand
the value it manifest. (1-5 slides)

5. Product description - It should be short and direct to the point but it
explains what a product is and why it’s worth purchasing. (1-2 slides)

6. Clearly articulated benefits as they relate to your target audience -
Describe the product in a precise and concise important information about
its features and benefits to arouse the interest of the audience to buy. (1- 5
slides)

7. Examples/successes - Benefits are the reasons customers buy the product
especially coupled with positive testimony is worth remembering and that
the product will never be forgotten by the audience. (1-3 slides)

8. Closing argument - It gives the summary or point of importance about the
product being presented. This is where you have to convey your audience to
trust you about the benefits they can gain to the products being offered.

In order for us to use the advanced features of a slide presentation tool, you
must first open MS PowerPoint to create a presentation.

After that, let’s move on to the advance features. Let’s do the following:

A. Adding Text on Slides
1. Open a multimedia slide presentation, click Layout in the Slides group
and choose your Office Theme. Type a title and subtitle (if necessary) in a
textbox using the WordArt Style and change its font size to 60.

2. Click Design tab from Menu and choose your slide design.
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B.) Adding Graphics and Photos

1. Click new slides

2. Click insert tab from Menu. Graphics that can be inserted may be taken
from your saved pictures, screenshot, and clip-art and downloads from
your computer or hard drives.

3. Click on to choose a photo that you want to insert on the slide and click
insert.

C.) SLIDE TRANSITION

1. Click the slide in the Thumbnail pane where you want to apply the transition
effect.
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2. Click the Transitions tab on the Ribbon

3. In the Transition Gallery, select to see all the available transitions.

4. Click the transition effect that you want for that slide.

5. To change the properties of the transition effect that you have chosen, click the
Effect Options in the Transition to This Slide group.
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6. Enter a time you prefer at Duration in the Timing group to set how fast the
transition goes.

7. If you want to apply the same transition effect to all the slides in the
presentation, select APPLY TO ALL command from the Timing group.

D.1.1 ADDING A HYPERLINK
1. To insert a hyperlink in our presentation, click first the text or image.
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2. Click the insert tab. In the Links group, click the Hyperlink command and the
insert Hyperlink dialog box will open.

3. a. To insert a Hyperlink to another file, click Existing File or Webpage. Click
the name of the file.

3. b. To insert a Hyperlink to another slide, click Place in This Document. Click
the name of the slide you would like to link to. Click ok.
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3. c. To insert a Hyperlink to create a new document, click Create New Document
option. Enter the Name of New Document. Click ok.

3. d. To insert a Hyperlink to an e-mail address, click E-mail Address option.

D. 1.2 EDITING A HYPERLINK
1. Right-click the text with hyperlink.
2. Click Edit Hyperlink from the task bar.
3. Edit the Hyperlink and click ok.
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D. 1.3 REMOVING A HYPERLINK
1. Right-click the text with the hyperlink.
2. Click Remove Hyperlink.

E. INSERTING ACTION BUTTONS
1. Click the Insert tab on the Ribbon.
2. In the Illustrations group, click the Shapes command. A drop-down

menu will appear. Click to locate Action Buttons located at the very
bottom.

3. Click the desired action button.
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4. Click the desired location on the slide. The Action Settings dialog box will
appear.

5. In the Action Settings dialog box, Click the Mouse Click or Mouse Over tab. If
you select the Mouse Click tab, the action button will perform its action only
when clicked and if you select the Mouse Over tab, the action will perform its
action when we move the mouse over it.
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6. In the Action Settings dialog box, Click Hyperlink to, after that click the Drop-
down Arrow and choose an option from the menu where you want to link the
action button whether you click it or you move the mouse over it.

7. Click Play Sound box, If you want a sound to play when the action button is
clicked. Choose a sound from the given options. You may also select Other
Sound to use a sound file from your computer.
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8. Click Ok button.

F.) 1.1 APPLYING ANIMATIONS TO TEXT OR OBJECTS
1. Select the text or object on the slide you want to animate.
2. On the Ribbon, select the Animations Tab. Click Add Animation in the

Advance Animation group. Select the animation effect. To see more
effects, click More Entrance Effects, More Emphasis Effects or More
Motion Paths.
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F.) 1.2 REMOVING ANIMATIONS ON TEXT OR OBJECTS
1. To remove an animation effects to text or objects, click the text or object

that you want to have no animation. Click NONE in the Animation
gallery in the Animation group.

G.) EMBEDDING AUDIO and VIDEO
1. Choose a slide where you want to embed audio or video.

2. Select the Insert tab.
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3. In the Media group, do any of the following:
a. In embedding an Audio file, Click Audio command. Click Audio on My PC if

the Audio file you are going to embed is in your computer. Click
Record Audio if you want to embed a recorded audio file.

b. In embedding a Video file, Click Video command. Either click Online Video,
If the Video file you are going to embed is online or clicks Video on
My PC, If the file you are going to embed is in your computer.
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What is It

Slides – According to Microsoft Office (2016), “slide is a single screen of a
presentation, and every presentation is composed of several slides”. Collectively, a
group of slides may be known as a slide deck typically created in PowerPoint.

Text Merriam Webster (2021) defined text as an actual use of language, as
distinct from a sentence which is an abstract unit of linguistic analysis. As used in
computer, text is a collection of words or letters that are to be understand by the
reader. Text is added, viewed, edited, and modified using a text editor or word
processing program. In adding the text, a keyboard is used. However, using touch
and an on-screen keyboard or through voice recognition can also be used.

Graphics Merriam Webster (2021) defined graphics as pictorial image or
series of images displayed on a computer screen.

Photos Webster Dictionary (2010) defined photo as a representation of a
person or scene in the form of a print or transparent slide; recorded by a camera on
light-sensitive material.

Slide Transition This the change from one image to the next in a slide show.
A “wipe” moves the next image onto the first either horizontally, vertically, in a
circle, like a checkerboard or in some other pattern. A “fade” gradually turns the
image into black or white, followed by the reverse action for the next one.

Hyperlink Merriam Webster (2021) defined hyperlink as a highlighted word
or picture in a document or Web page that you can click on with a computer mouse
to go to another place in the same or a different document or Web page.

Action Buttons An action button is an object on a slide that performs as
action when clicked or pointed to, such as jumping to another slide or playing a
sound. It is most commonly used for self-running presentations.

Animations Is something that makes slide objects move on a slide. It can
help make a PowerPoint presentation more dynamic, and help make information
more memorable.

Audio is a sound that is heard on a recording or broadcast.

Video is the visual part of a movie or recorded program, or something
recorded to watch in the future.
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What’s More

The possible uses of PowerPoint are countless. A slide show can help a
teacher/pupils teach and learn a lesson, illustrate an event in history, easily
display statistical information, or be used for output presentation. A slide show
can be a valuable tool for teaching, sharing and learning. PowerPoint presentations
are useful no matter what the topic and help communicate ideas to an audience.

The following are steps on how to create a basic PowerPoint presentation,
however certain steps may vary slightly depending upon what version of
PowerPoint you are using. (https://www.instructables.com/How-to-Create-a-PowerPoint-
Presentation/)

A.) Adding Text on Slides

Present Your Most Favorite Fruits in Your Community.
1. List your top three (3) favorite fruits in your community.
2. Open a multimedia slide presentation.
3. Add another slide.
4. Using the Title and Content slide layout, type your top three (3) most

favorite fruits in your community.

B.) Adding Graphics and Photos
5. Add another three (3) slides. Use two (2) Content slide layouts.

6. Type your title (Name of your favorite fruit in your community)

7. In the Left Content of each slide, add a photo or graphic of your favorite
fruits in your community.

8. In the right content of each photo or graphics, type the three (3) reasons
why you like those fruits.

C.) SLIDE TRANSITION
9. Put a transition effects on your slide presentation about your favorite
fruits in your community.

10. Apply your chosen transition to all the slides in your presentation.

D.) ADDING A HYPERLINK
11. Go back to the first slide. Create hyperlinks on your selected three (3)

favorite fruits in your community. Link each fruit to its corresponding
slide.

E.) INSERTING ACTION BUTTONS
12. For each slide, add the Previous and Next action buttons except for the

first and last slides. The first slide should have only the Next action
button while the last slide should only have the Previous action button.
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F.) APPLYING ANIMATIONS TO TEXT OR OBJECTS
13. Add animation effects to the text and objects of your presentation.

14. Apply the selected animations and effects to all your slides.

G.) EMBEDDING AUDIO and VIDEO
15. Insert an appropriate background music that will play across all the

slides.

16. Add another slide. On this slide, you must choose and insert at least
one video of your favorite fruit in your community about the benefits
you can get on it.

17. Save to my computer, type a filename “My Favorite Fruits” and close
your slide presentation.

What I Have Learned

 Multimedia presentation can be created using online and digital tools.
 It is combining multiple types of media presentation. You can use

combinations of images, audio, and video to make your point.
 It’s always better to create your own presentation. Do not copy other peoples’

work because it is considered plagiarism. If you need to borrow other
people’s ideas, you have to cite them or mention them as a source.

 To make a good multimedia and keep our presentation on point: choose
wisely, stay consistent, keep it short, keep it simple, keep it sharp, and think
you got it? Check again.

What I Can Do

Using the draft below, make your own PowerPoint Advertisement. Make sure to add
actual images and footage of your food product.

a. Create a new blank presentation by clicking File, New and then click
Blank Presentation.

b. In the Home tab, click Layout and select Blank.
c. Click Insert tab. In the Text group, click WordArt and then select any

from the given options.
d. Type your products name (ex. Calamay-Hati). Change the font size to 70.
e. Click Insert tab, click on Pictures to choose a photo that you want to

insert on the slide and click Insert. Move your photo to the left side of
the slide.
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f. Insert another WordArt of your choice and type “Very Delicious” Change
the font size to 50 and place it to the right side of the slide.

g. Add another WordArt of your choice and type “Affordable” Change the
font size to 50 and place it under the WordArt “Very Delicious”

h. Add another WordArt of your choice and type “Come and Taste our
Delicacy” Change the font size to 50 and place it under the WordArt
“Affordable”.

i. Add another slide.
j. Click Insert tab, click on Pictures to choose a photo of you eating your

product and insert it on the slide. Adjust and move your photo to the
center of the slide.

k. Click Insert tab, click on shapes and Add Action Button Back or
Previous to the left bottom corner off the slide and Hyperlink it to the
first slide.

l. Add another slide.
m. Click Insert tab, click on Pictures to choose a photo of the amount (coins

or bills) of your product and insert it on the slide. Adjust and move your
photo to the center of the slide.

n. Click Insert tab, click on shapes and Add Action Button Back or
Previous to the left bottom corner off the slide and Hyperlink it to the
first slide.

o. Add another slide.
p. Click Insert tab, In the media group click on the Video command and

select video on my PC to choose a video presentation about the steps in
making your product and insert it on the slide.

q. Click Insert tab, click on shapes and Add Action Button Back or
Previous to the left bottom corner off the slide and Hyperlink it to the
first slide.

r. Go back to the first slide, Click the WordArt “Very Delicious” and
Hyperlink it to the second slide. Click the WordArt “Affordable” and
Hyperlink it to the third slide. Click the WordArt “Come and Taste our
Delicacy” and Hyperlink it to the fourth slide.

s. On the first slide, add any Transition effect. In the Timing group,
deselect On Mouse Click and click After. Make it four seconds. Add a
Spin Emphasis animation effect on the image. In the Timing group, click
the Start drop-down arrow and select After Previous. Add a delay of 1
second.

t. On the second slide, add any entrance animation effect to the WordArt.
In the Timing group, click the Start drop-down arrow and select After
Previous. Add a delay of 1 second. Go back to Transitions tab. In the
Timing group, click the Start drop-down arrow and select After
Previous. Add a delay of 1 second.

u. On the third slide, add any entrance animation effect to the WordArt. In
the Timing group, click the Start drop-down arrow and select After
Previous. Add a delay of 1 second. Go back to Transitions tab. In the
Timing group, click the Start drop-down arrow and select After
Previous. Add a delay of 1 second.
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v. On the fourth slide, add any entrance animation effect to the WordArt. In
the Timing group, click the Start drop-down arrow and select After
Previous. Add a delay of 1 second. Go back to Transitions tab. In the
Timing group, click the Start drop-down arrow and select After
Previous. Add a delay of 1 second.

Save and close your slide presentation.

Assessment

Write your answers in your notebook.

1. What are the different uses of MS PowerPoint?
________________________________________________________________________

________________________________________________________________________

______________________________________________________

2. What are the benefits that we can get when we use MS PowerPoint?
________________________________________________________________________

________________________________________________________________________

______________________________________________________

3. How does MS PowerPoint helps you in making presentation?
________________________________________________________________________

________________________________________________________________________

______________________________________________________

Additional Activities

True or False. Write your answer in your notebook.

________ 1. Slide show elements can be animated and transitions can be applied to
each slide.

________ 2. Along with text and images, a user can embed videos in his or her slide
presentation

________ 3. You should NOT limit the number of words on each screen.

________ 4. Slide presentations are more effective for business presentations.

________ 5. Be sure the text is large enough to be read from a distance.
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Answer Key

References:

“Microsoft PowerPoint Environment”, July 13, 2021. https://prezi.com/m/4m_99z9nngpl/microsoft-
powerpoint-environment/

“How to create a PowerPoint Presentation”, July 22, 2021. https://www.instructables.com/How-to-
Create-a-PowerPoint-Presentation/
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